SC-2000USB
Quick Reference

*Be sure to read and understand this guide before using the machine. We recommend that you keep this guide
nearby for future reference.

LBA911001

Thank you for purchasing the SC-2000USB!
With your new Brother stamp printer, you can print personalised stamps for any purpose. Simply insert a stamp
cassette into the SC-2000USB, design your stamp with the enclosed P-touch Editor software or Stampcreator
Express software, and then print it out. Your customised stamp prints out in seconds. Stamps are available in various
sizes.
The many features of the P-touch Editor software and Stampcreator Express software make creating great stamps
quick and easy. Not only does the software automate the more complicated layout functions, but it also includes a
variety of pre-formatted templates for immediate use.

For Australia Only:
Warranty & Repair
For details about warranty on your Brother Product, the details are listed on the following link:
http://www.brother.com.au under Service & Support > Warranty. For warranty service (repair) of your Brother
product you will need to retain a copy of your sales docket and contact the Support Centre for location of the
nearest Authorised Warranty Centre (AWC).

Support
For technical support for your Brother Product other than what you can resolve through the User’s Guide, please
visit our website or our solutions website for FAQs/Troubleshooting, Drivers & Software, or contact the Product
Support Centre for any technical or customer care/support enquiry.

Product Support Centre: Australia
Brother International (Aust) Pty Ltd
Phone:

02 8875 6000

Fax:

02 9870 7223

E-mail:

please visit www.brother.com.au/ServiceSupport/EmailSupport.aspx and submit an e-mail enquiry.

Web Site:

www.brother.com.au

Solutions Site: http://solutions.brother.com

Our Technical Support Consultants are available 5 days a week by phone during the hours of 8.30am to 5pm
Monday to Friday.
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General Information
Compilation and Publication Notice
Under the supervision of Brother Industries, Ltd., this manual has been compiled and published, covering the latest
product’s descriptions and specifications.
The contents of this manual and the specifications of this product are subject to change without notice.
Brother reserves the right to make changes without notice in the specifications and materials contained herein and
shall not be responsible for any damages (including consequential) caused by reliance on the materials presented,
including but not limited to typographical and other errors relating to the publication.
© 2011 Brother Industries, Ltd.

Trademarks
The Brother logo is a registered trademark of Brother Industries, Ltd.
Brother is a registered trademark of Brother Industries, Ltd.
© 2011 Brother Industries, Ltd. All rights reserved.
Microsoft, Windows and Windows Vista are registered trademarks of Microsoft Corporation in the United States
and other countries.
The names of other software or products used in this document are trademarks or registered trademarks of the
respective companies that developed them.
Each company whose software title is mentioned in this manual has a Software Licence Agreement specific to its
proprietary programs.
All other brand and product names mentioned in this manual are registered trademarks of their respective
companies.
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Safety Precautions
Read all of these instructions and save them for later reference. Follow all warnings and instructions marked on the
product.

Warning

Tells you what to do to avoid the risk of injury.

Caution

Tells you about procedures you must follow to prevent damage to the printer.

The symbols used in this manual are as follows:
Action NOT allowed.

DO NOT disassemble the product.

DO NOT splash the product with or immerse the
product in water.

DO NOT touch a given portion of the product.

Mandatory action.

Unplugging.

Alerts to the possibility of electrical Shock.

■ To use the machine safely

Warning
Follow these guidelines to avoid fire, electric shock, or other damage.

■ The Printer
Unplug the power cord immediately and stop using
the printer during an electrical storm. There may be a
remote risk of electric shock from lightning.
Do not touch any metal parts near the print head. The
print head becomes very hot during use and remains
very hot immediately after use. Do not touch it
directly with your hands.
Dispose of plastic bags correctly and keep away from
babies and children. Do not wear or play with plastic
bags.
Unplug the power cord immediately and stop using
the printer if you notice any abnormal odour, heat,
discolouration, deformation or anything unusual
when the printer is in use or storage.
Do not disassemble the printer.
For inspection, adjustment and repair of the printer
contact the retail outlet where the printer was
purchased or your local authorised service centre.
Do not drop, hit or otherwise bang the printer.

Do not allow the printer to get wet in any way.
Do not use the printer with foreign objects in it. If
water or any foreign objects should enter the printer,
unplug the power cord from the electrical outlet and
remove the foreign object. If necessary, contact the
retail outlet where the printer was purchased or your
local authorised service centre.
Never look at the flash which may leak from the
stamp compartment.
DO NOT put your fingers on the edge of the machine
under the ink ribbon compartment cover. Doing this
may cause injury.
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Warning
Follow these guidelines to avoid fire, electric shock, or other damage.

■ Power Cord
Use only the authorised power source (220-240 V
AC) for the printer.
Use only the power cord included with the printer.

Do not cut, damage, alter or place heavy objects on
the power cord.
Do not use the power cord if it is damaged.

Do not handle the power cord or plug if your hands
are wet.
Do not overload the power outlet socket with too
many appliances or insert the power cord into a
damaged outlet socket.

Ensure the power plug is correctly inserted into the
power outlet.
If the printer will not be used for an extended period,
remove the power supply cord from the electrical
outlet.

Caution
Follow these guidelines to avoid fire, electric shock, or other damage.

■ The Printer
The standard electrical outlet should be close to the printer and be easily accessible.

■ Power Cord
Always hold the power plug when removing the power cord from or inserting it into the outlet. Pulling on the
power cord cable could cause problems with the power cord.

■ Installation/Storage
Place the printer on a flat, stable surface such as a
desk.
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Do not place any heavy objects on top of the printer.

General Precautions
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Be sure the machine is always placed on a level, stable surface.
Lift the machine by grabbing the specified areas.
Be sure to meet the power requirements specified for this machine.
Keep the machine and its accessories out of direct sunlight and extremely dusty places.
Do not expose the machine or any of its accessories to extremely high or extremely low temperatures or high
humidity.
Do not try to disassemble the machine or any of its accessories.
When connecting and disconnecting the cables, always be sure to grab only the connector.
Store the draft sheets, the ID label sheets, and the cleaning sheets in their packages. Do not use folded or
damaged draft sheets, ID label sheets, or cleaning sheets.
Never look at the flash which may leak from the stamp compartment.
Do not touch the machine’s internal parts since they become extremely hot after the machine has been used for
a long time.
Do not leave the machine for a long period of time with the ink ribbon compartment cover or stamp
compartment cover open or the xenon lamp unit or draft tray uninstalled.
Do not touch any of the machine’s internal sensors.
Avoid using the machine in extremely dusty places. Keep it out of both direct sunlight and rain.
Do not expose the machine to extremely high temperature or humidity.
Do not leave any rubber or vinyl on the machine for an extended period of time. Doing so may cause staining.
Do not clean the machine with alcohol or other organic solvents. Only use a soft, dry cloth.
Do not put any foreign objects into or heavy objects on the machine.
To avoid injures, do not touch the cutter’s edge.
Do not touch the print head, which becomes very hot when SC-2000USB is used. Even after the machine is
turned off, the print head remains hot for some time.
Use only the power supply cord designed exclusively for this machine. Use of any other cord will void the
warranty.
Use only the attached interface cables for this machine. Use of any other cable will void the warranty.
When the machine is not being used for a long period of time, disconnect the power supply cord.
Do not try to disassemble the SC-2000USB.

System Requirements
Computer Requirements
Check that your system meets the following requirements.
• OS: Windows® XP / Windows Vista®*1 / Windows® 7*1
• Interface: USB port (USB Spec 1.1 or 2.0 protocol)
Serial port (9-pin, RS-232C, supports 115,200 bps)
• Hard Drive: Over 70MB of available space*2
• Memory: Windows® XP: 128 MB or more
Windows Vista®: 512 MB or more
Windows® 7: 1 GB (32-bit) or 2 GB (64-bit) or more
• Monitor: SVGA, high color or higher graphics card
• Others: CD-ROM drive, pointing device
*1
The PC should meet Microsoft®’s recommendations for the OS installed.
*2
Required available space when installing the software with all of the options.
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Unpacking
SC-2000USB

Draft tray slot

Mode and Set buttons
LCD display

Stamp compartment
cover

Xenon lamp unit release button

Exit slot

Xenon lamp unit
ID label slot

Ink ribbon
compartment cover

Power switch

Power supply cord (for connecting the SC-2000USB to the AC outlet)
For the UK and Ireland

☞ The illustration is for UK.
The shape of the plug may vary
depending on the country/region.

Interface cables (for connecting the
SC-2000USB to the computer)

USB interface cable (for the USB port
of a PC running Windows® XP/
Windows Vista®/Windows® 7)

Serial interface cable (for the serial
port of a PC running Windows® XP/
Windows Vista®/Windows® 7)

150 draft sheets (for printing the data
in order to engrave the stamp)

9 cleaning sheets (for cleaning the
rollers)

5 ID label sheets (for printing a label
that can be attached to each stamp
for identification)
size 1438 ( × 2)
size 1850 ( × 2)
size 2770 ( × 1)
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Draft tray (for feeding in the draft
sheets)

Print head cleaning pen (for cleaning
the print head)

Stamp correction pen (for correcting
the engraved stamp)

5 stamps with caps
size 1438 ( × 2)
size 1850 ( × 2)
size 2770 ( × 1)

5 stamp skirts

5 grips

CD-ROM containing the PC software and their manuals

Precautions:

• Be careful that the CD-ROM is
not scratched.

• Do not subject the CD-ROM to
extremely high or extremely low
temperatures.

• Do not put heavy objects on the
CD-ROM.

Brother Industries, Ltd. and its suppliers possess all rights and copyrights to this software (including, but not limited to,
the programming, images, clip art, templates, and text incorporated into the software), the text in the enclosed
manuals, and duplicates of the software. This software, either in part or in whole, may not be duplicated, modified,
reverse-engineered, disassembled or decompiled without permission.
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Changing the LCD display language
a While holding down the [Set] button, turn on the SC-2000USB. When
“READY” appears in the display, release the [Set] button.
Mode
Set

b Press the [MODE] button three times until “LANGUAGE” appears.
Mode
Set

c Press the [Set] button once.
d Press the [MODE] button until the name of the desired language
appears.

e Press the [Set] button to apply the setting.
f Turn the SC-2000USB off, then on again.
This completes the setting of the LCD display language.

8

ENGLISH
DEUTSCH
FRANCAIS
NEDERLANDS
NORSK
SVENSKA
ITALIANO
PORTUGUÊS
ESPAÑOL

Connecting the Interface and Power Supply Cables
After connecting the interface and power supply cables to the SC-2000USB, it can be used to create stamps from any
layout that you design in the P-touch Editor software or Stampcreator Express software installed on your computer.
a Be sure both the SC-2000USB and the computer are turned off.
b Attach the appropriate interface cable connector to the computer port specified in the table below.
P-touch Editor software
Ver. 4.2 for Windows®

Operating system

Computer port

Windows® XP / Windows Vista® / Windows® 7

USB port or Serial port (9 pin)

☞ After connecting the 9-pin connector, be sure to tighten the screws to lock it into place.
c Connect the other end of the interface cable to the interface port on the back of the SC-2000USB.
d Insert one end of the power supply cord into the power supply port on the SC-2000USB and the other end of the cord
into an AC outlet.
e Flip the power switch on the right side of the SC-2000USB to “ | ”, and then turn on the computer. The message
“READY” appears on the LCD display of the SC-2000USB when it is ready to begin engraving stamps.

9-pin connector
8-pin connector
USB connector

USB connector port
Power switch
Power supply port

8-pin connector port

Back:

8-pin connector

USB connector
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Installing the Software
P-touch Editor, Stampcreator Express and printer driver
Before stamps can be engraved on the SC-2000USB, the stamp-editing tool P-touch Editor software, Stampcreator Express
software and the SC-2000USB printer driver must be installed.
Follow the procedure described below to install the stamp-editing tool P-touch Editor software onto the computer.
☞ You must have administrator privileges in order to install the software on a computer running Windows® XP,
Windows Vista® or Windows® 7.
a Connect the SC-2000USB to the computer’s USB or serial port, and
then turn on only the computer.
b Insert the SC-2000USB CD-ROM into the computer’s CD-ROM drive.
A dialog box that allows you to select the language and to select which
components to install. Select the language of Windows® that you are
using, and then click the Standard Installation button.
The InstallShield® Wizard for installing the software starts up.
If the dialog box does not appear automatically, go to My Computer
(Computer), double-click the CD-ROM icon, and then double-click
Setup.exe.

For Windows Vista® and Windows® 7 users only
When the AutoPlay dialog box appears, click “Run Setup.exe”.

c When the Licence Agreement dialog box appears, please read the
licence agreement carefully.
If you accept all terms of the preceding licence agreement, click the
Yes button to continue.
d In the Customer Information dialog box, type the necessary
information into the appropriate boxes, and then click the Next button.
If the information has already been registered in Windows®, it will
appear in the appropriate boxes.
e In the Choose Destination Location dialog box, if it is OK to install the
P-touch Editor software into the folder shown in the “Destination
Folder” box, click the Next button.
To install the software into a different folder, click the Browse button,
and then select the folder.
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f In the Add shortcut dialog box, specify where to add shortcuts for
P-touch Editor, and then click the Next button.
g If you are satisfied with the settings that appear in the Start Copying
Files dialog, click the Next button to begin copying files.
h When the Driver Setup dialog box appears, select “USB cable” if the
SC-2000USB is connected to a USB port or select “Serial cable” if the
SC-2000USB is connected to a serial port, and then click the OK
button.

For a USB port connection, continue with step 9.
For a serial port connection, continue with step 16.

i

For a USB port connection:
For Windows Vista® and Windows® 7 users only
After checking the files during the installation procedure, when the
Windows Security box appears, click the Install button.

For Windows® XP users only
After checking the files during the installation procedure, when the
Software Installation dialog box appears, click the Continue Anyway
button.

j When this Driver Setup dialog box appears, connect a USB cable from
your computer to the SC-2000USB. Then turn the SC-2000USB on.
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For Windows Vista® and Windows® 7 users
k Click the Finish button to exit the wizard.

This completes the installation of P-touch Editor, Stampcreator Express
and the printer driver for USB connection.
Restart your computer now.

For Windows® XP users
k The Found New Hardware Wizard starts up.
When asked if Windows can connect to Windows Update to search for
software, select “No, not this time”, and then click the Next button.

l In the next dialog box, select “Install the software automatically
(Recommended)”, and then click the Next button.
m When the Hardware Installation dialog box appears, click the
Continue Anyway button.

n Click the Finish button to exit the Found New Hardware Wizard.
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o Click the Finish button to exit the wizard.

This completes the installation of P-touch Editor software, Stampcreator Express software and the printer driver for a
USB connection.
Restart your computer now.

For a serial connection:
p A Driver Setup dialog box appears, allowing you to select whether to
install or uninstall the printer driver. Check that “Brother SC-2000USB”
is selected for installation, select “Install”, and then click the Next
button.

q A dialog box appears, allowing you to select the COM port where the
SC-2000USB is connected. Select “COM1:” if the SC-2000USB is
connected to the COM1 port, “COM2:” if the SC-2000USB is
connected to the COM2 port, and then click the Next button.

r In the dialog box that appears, allowing you to confirm how the installation will be carried out, check that the
installation will be carried out as desired, and then click the Next button.
s A dialog box showing that the printer has been installed appears.
Click the Next button.
t Click the Finish button to exit the wizard.

This completes the installation of P-touch Editor software, Stampcreator Express software and the printer driver for a
serial connection.
Restart your computer now.
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Using the Software
P-touch Editor software
a Use P-touch Editor to create a stamp design.
For details on using the P-touch Editor software to create a stamp design, refer to the P-touch Editor Help, which can
be opened by selecting “How To” from the “Help” menu in the P-touch Editor software.
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b Engrave a stamp with the stamp design created in step 1.
Click

to display the Print Properties. (If they are already displayed,

skip this step.)
Click

in the Print Properties to display the Printer Setup dialog

box.

Check that “Brother SC-2000USB” is selected below “Application
Matching Printer”, and then click the OK button.
Click

in the Print Properties. The Print dialog box appears.

Select “Stamp”, and then select the appropriate “Document Type”
setting.
Logo: Best for stamps with a logo mark
Text: Good for stamps with text only
Text+Photo: Good for stamps with text and photos (graphics)
Photo: Best for stamps containing photos with a “Photo Enhance”
effect applied.
Then, click the Print button to start printing a draft sheet.
For details on engraving a stamp, refer to the section “Engraving a
stamp” on page 22 of this Quick Reference.

c Print an ID label.
Click

in the Print Properties. The Print dialog box appears.

Select “ID Label”, and then select the appropriate “Document Type”
setting.
Insert an ID label sheet into the ID Label Slot of the SC-2000USB, then
click the Print button to start ID label printing.
For details on printing an ID label, refer to the section “Printing an ID
label for the engraved stamp” on page 24 of this Quick Reference.
For details on assembling a stamp, refer to the section “Assembling the
Stamp” on page 25 of this Quick Reference.
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Stampcreator Express software
a Start up Stampcreator Express by following the procedure described
below.
(a) Click the start button in the taskbar to display the Start menu.
(b) Select “All Programs”.
(c) Select “Stampcreator Express”.
(d) Click “Stampcreator Express”.

b After Stampcreator Express is started, the Style Selection window
appears.
Click the Browse button.

c In the Select a Style dialog box, click the arrow in the “Category” box,
and then click the desired category to select it.
In this example, select the category “02_OFFICE”.

d Select a style by double-clicking it or by clicking the style, then
clicking the OK button.
In this example, select the style “203”.

e The Type Text window appears.
Select the text line that you want to change by clicking it, by selecting
the number of the text line from the drop-down list, or by pressing the
Enter key.
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In this example, select text line 1, and then type in “Brother Industries,
Ltd.”
Change text lines 2 and 3 as you wish.
If the entered text exceeds the length of the original text, the text size is
automatically adjusted so that the text fits within the text field.

f To change the font, character style or spacing of each text line, select
the text line, and then click

to display the Font dialog box.

Select the Font from the “Font” box, click the appropriate button to
select the bold or italic character style, and then set the character
spacing. Then, click the Close button to return to the Type Text
window.
☞ Note: The spacing is applied to all text lines.
In this example, select “Arial Black” as the Font, select the italic
character style, and then set the Spacing to “-2 %”.

g When you have finished designing the stamp, click the Next button.
h Below “Print ID Label or Make Stamp?” in the next window that
appears, click the Stamp button.

When the Print Stamp dialog box appears, check the stamp size, and
then click the OK button.

For details on engraving a stamp, refer to the section “Engraving a
stamp” on page 22 of this Quick Reference.
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i Below “Print ID Label or Make Stamp?” in the window, click the ID
Label button.

When the Print ID Label dialog box appears, check the stamp size,
insert the appropriate ID label into the ID label slot of SC-2000USB,
and then click the OK button.
For details on printing an ID label, refer to the section “Printing an ID
label for the engraved stamp” on page 24 of this Quick Reference.
For details on assembling a stamp, refer to the section “Assembling the
Stamp” on page 25 of this Quick Reference.
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Adding new styles to the Stampcreator Express software
A style in the Stampcreator Express software is a type of template. A template is created from the same type of file
designed using the P-touch Editor software.
For details on using the P-touch Editor software, refer to the User’s Guide, which can be opened by selecting “User’s
Guide” from the “Help” menu in the P-touch Editor software.
a When creating a stamp design in the P-touch Editor software, set “Text
Layout” on the Text Properties dialog box to “Fixed Frame Size”.
To select a “Text Layout” setting:
Open the Text Properties dialog box by double-clicking the text object
or clicking the text object and selecting “Text…” from the “Format”
menu.

Select “Fixed Frame Size” in the “Text Layout” box, and then click the
Details button.

In the Text Options dialog box, select the “Shrink to Fit” option.
If the “Maintain Height-to-Width Proportion” check box is selected,
the text size is automatically reduced so that the text fits within the text
field when the text exceeds the length of the original text.

If the “Maintain Height-to-Width Proportion” check box is cleared, the
text width is automatically adjusted so that the text fits within the text
field when the text exceeds the length of the original text.
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b Save the stamp design as a template file in the “.lbl” file format.
Select “Save As…” from the “File” menu.

Save the template file in the following folder.
<Windows_drive>:\Program Files\Brother\SE42\Template\SC2000\

In this example, make a new folder titled “09_Original” in the
“SC2000USB” folder and name the template file “901”.
Then, click the Save button.

c Start up Stampcreator Express, and then click the Browse button.
“09_Original” is available in the “Category” list in the Select a Style
dialog box, and the new style “901” is available in the “09_Original”
category.
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Using the SC-2000USB
After you have designed a stamp layout using the P-touch Editor software or Stampcreator Express software, you can
engrave it into a stamp.

Installing the ink ribbon cassette
a Press down on the ink ribbon compartment cover button to open the
cover.
☞ Open and close the ink ribbon compartment cover by pressing
only on the positions specified.

b If the ink ribbon in the cassette is loose, turn it over and use your finger
to wind the toothed wheel on the large knob on the right side until
there is no slack in the ribbon.

c Insert the knobs on the left end of the cassette into the slots on the left
side of the compartment, then push down on the right end of the
cassette so that the knobs on the right side slide into the slots on the
right side of the compartment.

Ink ribbon
cassette

Slots

Ink ribbon compartment

d Slowly close the ink ribbon compartment cover so that it locks into
place.
☞ Be careful not to pinch your fingers with the compartment cover while closing it.

Loading draft sheets and installing the draft tray
a Slide out the inner tray.
b Lift up the draft tray lid.
c

c Place the draft sheets (with the words “DRAFT SHEET” facing up) into
the draft tray so that the corners of the sheets fit under the tabs in the
front corners of the tray.
b

☞ No more than 50 draft sheets should be loaded into the draft tray.
Be sure that there is no dust, fingerprints, etc. on the draft sheets.
Do not use a draft sheet that has been folded.
Be sure that a cleaning sheet is not accidentally inserted together
with the draft sheets.

a

d Close the draft tray lid.
e Slide the inner tray back into the outer case.
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f Fully insert the draft tray straight into the draft tray slot.
☞ Be careful not to pinch your fingers while inserting the draft tray.
To remove the draft tray, grab its outer case, then pull out the entire
draft tray.

Draft tray
Draft tray slot

After installing the ink ribbon cassette and the draft tray loaded with draft sheets, you can use P-touch Editor software
or Stampcreator Express software to create any layout containing graphics and text, and then engrave it into a stamp.

Engraving a stamp
a Turn on the SC-2000USB and start up the computer.
b Start up P-touch Editor and make sure that “SC-2000USB” is selected as the printer in the Print Setup dialog box ([Print
Setup] command in the [File] menu of the PC software).
c In the Page Format setting of the Page Properties, select the desired
stamp size, then design your stamp layout.

d Click the [Print] command in the [File] menu, select “Stamp” in the Print dialog box, then click the OK button. After
the data is printed onto the draft sheet, which is then fed over the xenon lamp, the message “INSTALL STAMP !”
appears on the LCD display of the SC-2000USB.
e Lift open the stamp compartment cover, slowly pull the lever toward
you to open the doors in the stamp compartment, and then check that
the printed draft sheet is stopped over the xenon lamp unit.
☞ Be careful not to touch the draft sheet that is stopped over the
xenon lamp unit.
Do not allow the clear plastic surface of the xenon lamp unit to
become dirty or scratched. Use a soft cloth to wipe off any dust on
the clear plastic surface.
To cancel engraving, press the Mode button on the SC-2000USB
until “CANCEL” appears on the display, then press the Set button to
feed out the draft sheet.
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Stamp compartment cover
Doors

Lever

f Remove the cap from a stamp, insert the stamp between the doors so
that the teeth in the centre of the doors fit into the notches in the centre
of the stamp and so that the stamp surface lies flat on the printed draft
sheet, and then slowly close the doors.
☞ Do not use a stamp that has the protective film covering removed
from the stamp surface or that has been assembled with the skirt
and grip.
Before inserting the stamp, be sure that there is no dust on the
protective film covering its surface.
Be sure that the stamp is at the same temperature as the
SC-2000USB, otherwise the stamp may not be engraved correctly.
Be careful not to break the ink bag inside the stamp.
Stamp
Arrow
Lever

g Close the stamp compartment cover so that it locks and causes the xenon lamp to flash. The message “REMOVE
STAMP !” appears on the display.
☞ Be careful not to pinch your fingers with the compartment cover while closing it.
Do not open the stamp compartment cover until after the flash has fired.
h Open the stamp compartment cover and the doors, remove the stamp,
and then slowly peel the protective film off the surface of the stamp.
The printed draft sheet is fed out from the exit slot on the top right end
of the SC-2000USB.
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Printing an ID label for the engraved stamp
After we have engraved the stamp, we can print the same layout on a label which we can attach to our stamp to easily
identify it. In order to see how the stamp will appear when it is engraved, the ID label can be printed before engraving the
stamp.
a Insert an ID label sheet, so that the words “ID LABEL” can be read,
straight into the narrow ID label slot to the right of the draft tray slot.

ID label slot

☞ Be careful not to touch the print area of the ID label sheet since
dust, fingerprints, hand creams, etc. may prevent the characters
from being printed correctly.
Be sure that the ID label is the correct size.
Do not use an ID label that has been folded.

b With the layout of the engraved stamp displayed in P-touch Editor,
click the [Print] command in the [File] menu, select “ID Label” in the
Print dialog box, then click the OK button.
c After the label is printed and fed from the exit slot on the top right end
of the SC-2000USB, remove it, peel off the ID label from its backing
paper, affix it to the top of the stamp grip.

ID label

Grip
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Assembling the Stamp
a With the cap on the stamp, place it face down.
Grip

☞ If the packing board has been removed, put it back into the stamp.
b Place the skirt over the top of the stamp and push it down firmly.

c

c Place the grip over the skirt and push it down firmly so that the
fasteners hook onto the tabs and the ink bag inside the stamp breaks.
d Keep the stamp facing down to speed up the flow of the ink.
☞ The length of time that you must wait before the ink begins to flow
from the stamp depends on many factors, such as the size of the
engraved area and the room temperature.
Keep the stamp covered when it is not being used.

Skirt
Packing
board

b
Stamp
Cap

Correcting the Engraved Stamp
Even after the stamp is engraved, it can be corrected using the stamp correction pen to seal any undesired area in the
stamp so that ink will not flow through it.
a With the cap on, hold the enclosed stamp correction pen upright and
shake it well.
b Remove the cap and press the tip of the pen down onto a piece of
scrap paper until ink appears.
c Make a test stamp, and then use the pen to fill in any undesired areas
in the surface of the engraved stamp.
☞ Do not try stamping until the correction fluid is completely dry.
Be sure to apply plenty of correction fluid to the areas that you
wish to fill in.
Keep the cap on the stamp correction pen when it is not being
used.
☞ You can also use the correction pen to make corrections if ink has
run from the space between the glossy area and the non-glossy
area around the printing surface.
☞ When applying the correction fluid, place plenty of fluid on the
area you want to correct like you are making a point with the tip of
the pen, so the tip of the pen does not rub off the area you are
correcting.
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Refilling the Stamp Ink
If the stamp is faint or incomplete, use the ink bottle (sold separately) to refill the ink.
a Remove the grip from the stamp.

Grip

b Use the ink bottle to add five drops of ink to each refill hole in the
stamp.
☞ Be extremely careful when adding ink.
Do not use ink other than that specified, otherwise the stamp may
be damaged.
If too much ink is added, it may start leaking from the stamp’s
surface. In that case, make a test stamp on scrap paper to remove
any excess ink.
c Put the grip back on the stamp.
☞ Immediately after refilling the ink, keep the stamp facing down
until the ink begins to flow from the stamp.
After refilling the ink, be sure to put the cap back on the ink refill
bottle.
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Ink bottle

Refill holes

Maintenance
Cleaning the draft sheet rollers
The draft sheet rollers should be cleaned after 50 draft sheets (1 pack) have been printed.
a Peel off the pre-cut section from the side of the cleaning sheet marked
SIDE A.

SID

EA

☞ Never reuse a cleaning sheet.
Do not use a cleaning sheet that has been folded or damaged or
has had any part of the paper other than the pre-cut section
removed.

b Load the cleaning sheet into the draft tray with side A facing up as
shown in the illustration.

Side A

c Insert the draft tray into the draft tray slot.
d Press the Mode button on the SC-2000USB until “CLEAN” appears on
the LCD display.

Draft tray

e Press the Set button to feed in the cleaning sheet, and then eject it from
the exit slot.
☞ Store unused cleaning sheets in their packages and do not expose
them to high temperatures, high humidity or direct sunlight.

Cleaning the ID label rollers
The ID label rollers should be cleaned if the ID labels often feed incorrectly.
a Peel off the pre-cut section from the side of the cleaning sheet marked
SIDE A.
Side A
SIDEA

☞ Never reuse a cleaning sheet.
Do not use a cleaning sheet that has been folded or damaged or
has had any part of the paper other than the pre-cut section
removed.
b Insert the cleaning sheet into the ID label slot with side A facing toward
the ink ribbon compartment.
c Press the Mode button on the SC-2000USB until “CLEAN” appears on
the LCD display.

ID label slot

d Press the Set button to feed in the cleaning sheet, and then eject it from
the exit slot.
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Cleaning the print head
a Flip off the SC-2000USB’s power switch.

Print head cover

b Open the ink ribbon compartment cover, then pull back the print head
cover.
c Use the enclosed print head cleaning pen to gently wipe back and
forth along the print head.
☞ Be careful not to touch the print head.
Keep the cap on the print head cleaning pen when it is not being
used.

Print head

d Release the print head cover and close the ink ribbon compartment
cover.
e Try printing again.
f If the printed characters are still blurred, repeat steps a through e.

Replacing the xenon lamp unit
The xenon lamp unit has a life span of approximately 2000 flashes. When the message “REPLACE Xe UNIT” appears on
the display, the xenon lamp unit must be replaced.
a Press the Mode button on the SC-2000USB until “RESET COUNTER” appears on its display, then press the Set button.
b Slide the xenon lamp unit release lever up and pull out the xenon lamp
unit.

Xenon lamp unit
release lever

c Fully insert the new xenon lamp unit until it locks into place. Check
that “N = 0” appears on the display of the SC-2000USB.

Xenon lamp unit
compartment

d Press the Set button on the SC-2000USB.
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Troubleshooting
PROBLEM

SOLUTION

• Nothing happens after the OK button is clicked in the
Print dialog box.

• Delete the print job and after turning the SC-2000USB
off, then on again, try printing again.

• The printed characters are blurred.

• Clean the print head as explained on page 28.

• Some of the printed characters are missing.

• Clean the print head as explained on page 28.
• Check that there is no slack or wrinkles in the ink
ribbon.
• If there is dust, fingerprints, etc. on the draft sheet or
ID label sheet, use a clean sheet.

• The characters are not printed on the ID label or
engraved in the stamp in the correct position.

• Check that the ID label or stamp is the correct size.
• If the problem cannot be corrected, contact your
service representative.

• A draft sheet was not fed from the draft tray.

• Check that a draft sheet has been loaded in the draft
tray.
• Check that the draft sheet has been correctly loaded
into the draft tray.
• Check that no more than 50 draft sheets are loaded
into the draft tray.
• Check that the draft tray has been fully inserted into
the draft tray slot.
• Clean the draft sheet rollers as explained on page 27.

• A draft sheet or ID label sheet does not feed into the
ID label slot.

• Check that the ID label sheet has been inserted into
the ID label slot as far as possible.
• Check that the ID label sheet is inserted so that the
words “ID LABEL” can be read.
• Check that the ID label is the correct size.
• Clean the ID label rollers as explained on page 27.

• The stamp cannot be inserted.

• Be sure to open the doors within the stamp
compartment by pulling the lever toward you.
• Check that the cap was removed from the stamp
before trying to insert it.
• Check that the skirt is not attached to the stamp before
trying to insert it.
• Check that the grip is not attached to the stamp before
trying to insert it.

• The draft sheet is fed out before the message “INSTALL
STAMP !” is displayed.

• Turn off the machine, and wait a while before turning
it back on and trying again to engrave a stamp.

• The stamp could not be engraved.

•
•
•
•

Check that a stamp is inserted.
Check that the stamp is inserted correctly.
Check that the stamp is the correct size.
Check that the message “INSTALL STAMP !” appears
on the LCD display and that the printed draft sheet has
stopped over the xenon lamp unit.
• Check that the stamp compartment cover is closed so
that it locks.
• If the problem cannot be corrected, contact your
service representative.
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PROBLEM

SOLUTION

• The xenon lamp flashed, but the desired stamp could
not be engraved.

• Check that the cap was removed from the stamp
before it was inserted.
• Check that there is no dust on the protective film
covering the surface of the stamp.
• Check that the clear plastic surface of the xenon lamp
unit is not dirty.
• Check that the printed draft sheet stopped over the
xenon lamp unit before trying to engrave a stamp.
• The lines in the layout are too thin, the text is too
small, or the fill pattern is too detailed.
• Replace the xenon lamp unit as explained on page 28.

• The stamp was engraved too much.

• The layout is too detailed.

• The stamp was not engraved well enough.

• Check that the clear plastic surface of the xenon lamp
unit is not dirty.
• Replace the xenon lamp unit as explained on page 28.

• Half of the stamp was either engraved too much or not
enough.

• Check that the stamp is inserted so that its surface lies
flat on the printed draft sheet before engraving it.

• The stamp is attached to the printed draft sheet.

• Check that the protective film was not peeled off the
surface of the stamp before it was engraved.

• The draft sheet is not fed out after the stamp is
engraved (the xenon lamp flashed).

• Check that the draft sheet feeds out automatically the
next time that an ID label sheet or another draft sheet
is printed.

• The draft sheet or ID label sheet is jammed within the
unit or the error messages “REMOVE LABEL 1”,
“REMOVE LABEL 2”, or “REMOVE LABEL 3” appears
on the display.

• Turn off the SC-2000USB, then remove the jammed
draft sheet or ID label sheet as explained on page 31.
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Removing a jammed draft sheet or ID label sheet
For a jam at the draft tray slot (“CHECK TRAY !” appears on the display):
a Grab the outer case of the draft tray, then pull out the tray.

b Pull out the jammed draft sheet.
☞ Do not pull too hard.

For a jam at the ID label slot (“REMOVE LABEL 1” or “CHANGE LABEL” appears on the display):
Slowly pull out the jammed draft sheet or ID label sheet.
☞ Do not pull too hard.

For a jam in the ink ribbon compartment (“REMOVE LABEL 1”, “REMOVE LABEL 2” or “REMOVE LABEL 3” appears on
the display):
a Open the ink ribbon compartment cover and remove the ink ribbon
cassette.
b Slowly pull the jammed draft sheet or ID label sheet out of the ink
ribbon compartment.
☞ Do not pull too hard.

For a jam near the xenon lamp unit (“REMOVE LABEL 3” appears on the display):
a Open the ink ribbon compartment cover.
b Slide the xenon lamp unit release lever up and pull out the xenon lamp
unit.
c Put your hand into the xenon lamp compartment and slowly pull out
the jammed draft sheet or ID label sheet.
☞ Do not insert your hand too far into the xenon lamp compartment.
Do not pull too hard.
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Error Message List
MESSAGE

SOLUTION

CLOSE COVER !

• Close the ink ribbon compartment cover.

CHECK RIBBON !

• Install the ink ribbon cassette.
• Replace the ink ribbon cassette.

INSTALL Xe UNIT

• Install the xenon lamp unit.

REPLACE Xe UNIT

• Replace the xenon lamp unit.

INSERT LABEL !

• Insert an ID label sheet into the ID label slot.

CHANGE LABEL !

• Correctly insert the specified draft sheet or ID label sheet into the ID label slot.

REMOVE LABEL 1

• Remove the draft sheet or ID label sheet from the ID label slot or pull out the draft tray
and remove the draft sheet.

REMOVE LABEL 2

• Open the ink ribbon compartment cover, and then remove the draft sheet or ID label
sheet.

REMOVE LABEL 3

• Open the ink ribbon compartment cover, remove the xenon lamp unit, and then
remove the draft sheet or ID label sheet.

CHANGE STAMP !

• Insert a stamp that is the correct size.

RESET STAMP !

• Re-insert the stamp.

I/F ERROR !

• Check the interface cable connections.
• For Serial connection only, check the COM port setting on the PC.
Display the printer Properties box, and then select the following setting for "Port
Setting" of the COM port.
Bits per second : 115200
Data bits : 8
Parity : None
Stop bits : 1
Flow Control : Hardware

• Contact your service representative.
CACHE FULL !

• Check the interface cable connections.
• Contact your service representative.

SRAM DEFECT !

• Contact your service representative.

HEAD ERROR !

• Contact your service representative.

Xe UNIT ERROR !

• Replace the xenon lamp unit.
• Contact your service representative.

SIZE PCB ERROR!

• Contact your service representative.

CHECK TRAY !

• Load draft sheets into the draft tray, and then insert the draft tray into the draft tray slot.
• Clean the draft sheet rollers using a cleaning sheet.
• Contact your service representative.

CHARGE ERROR !

• Turn off the machine, and wait for one minute before turning on the machine and
trying to print again.
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